
Microsoft Excel 2002 Keyboard Shortcuts
ALT+' (apostrophe) Display the Style dialog box. 

ALT+ the underlined letter in an optn Select an option, or select or clear a check box. 

ALT+; (semicolon) Select the visible cells in the current selection. 

ALT+= (equal sign) Insert an AutoSum formula with the SUM function. 

ALT+0128 Enters the euro symbol. 

ALT 0162 Enters the cent character in Microsoft Excel 

ALT+0163 Enters the pound sterling character 

ALT+0165 Enters the yen symbol 

ALT+A In Help, switch to the Answer Wizard tab. 

ALT+A Adds interactivity to the range or sheet being sent. 

ALT B Apply or remove the bottom border in Microsoft Excel. 

ALT+B If the Bcc box is displayed, opens the Address Book for the Bcc box. 

ALT+C In Help, switch to the Contents tab. 

ALT+C Moves the selected field into the Column area. 

ALT+C Opens the Address Book for the Cc box. 

ALT+D Apply or remove the downward diagonal border. 

ALT+D Moves the selected field into the Data area. 

ALT+DOWN ARROW Display more Help topics in the Assistant list 

ALT DOWN ARROW Open the selected drop-down list in Microsoft Excel. 

ALT+DOWN ARROW Display a drop-down list of the values in the current column of a list (list: A series of worksheet rows

that contain related data, such as an invoice database or a set of client names and phone numbers.

The first row of the list has labels for the columns.). 

ALT+DOWN ARROW In the cell that contains the drop-down arrow, displays the AutoFilter list for the current column. 

ALT+DOWN ARROW Displays the drop-down list for a field in a PivotTable or PivotChart report. Use the arrow keys to select

the field. 

ALT+E L Delete the current sheet (Edit menu, Delete Sheet command). 

ALT+E M Move or copy the current sheet (Edit menu, Move or Copy Sheet command). 

ALT+ENTER Start a new line in the same cell. 

ALT ENTER Start a new line in the same cell in Microsoft Excel. 

ALT+F4 In the Help windows, close the Help window 

ALT+H If cells in multiple rows are selected, apply or remove the horizontal divider. 

ALT+I In Help, switch to the Index tab 

ALT+J Goes to the Subject box. 

ALT+K Checks the names in the To, Cc, and Bcc boxes against the Address Book. 

ALT L Apply or remove the left border in Microsoft Excel. 

ALT+L Displays the PivotTable Field dialog box for the selected field. 

ALT+LEFT ARROW Go to the previous Help topic 

ALT+number Select a Help topic from the list the Assistant displays. ALT+1 is the first topic, ALT+2 is the second,

and so on. 

ALT+O In the Help windows, dsplay the Options menu to access any Help toolbar (toolbar: A bar with buttons

and options that you use to carry out commands. To display a toolbar, use the Customize dialog box

(point to Toolbars on the View menu and click Customize). To see more buttons, click Toolbar Options

at the end of the toolbar.) command. 

ALT+O Opens the Options menu for access to the Options, Bcc Field, and From Field commands. 

ALT+O H R Rename the current sheet (Format menu, Sheet submenu, Rename command). 

ALT+O, and then press B In the Help windows, display the previously viewed topic 

ALT+O, and then press F In the Help windows, display the next topic in a previously displayed sequence of topics 

ALT O, and then press H In the Help windows, return to the specified home page in Microsoft Excel 

ALT+O, and then press I In the Help windows, open the Internet Options dialog box for Microsoft Internet Explorer, where you

can change accessibility settings 
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ALT+O, and then press P In the Help windows, print all topics in a book or a selected topic only 

ALT+O, and then press R In the Help windows, refresh the topic (useful if you have linked to a Web page) 

ALT+O, and then press S In the Help windows, stop the Help window from opening a Help topic (useful if you want to stop a Web

page from downloading) 

ALT+O, and then press T In the Help windows, hide or show the pane with the Contents, Answer Wizard, and Index tabs 

ALT P Moves the selected field into the Page area in Microsoft Excel. 

ALT+P Opens the Outlook Message Options dialog box (Options menu, Options command). 

ALT+PAGE DOWN Move one screen to the right. 

ALT+PAGE UP Move one screen to the left. 

ALT+PERIOD Opens the Address Book for the To box. 

ALT+PRINT SCREEN Copy a picture of the selected window to the Clipboard. 

ALT R Apply or remove the right border in Microsoft Excel. 

ALT+R Moves the selected field into the Row area. 

ALT+RIGHT ARROW Go to the next Help topic 

ALT+S Sends the e-mail message. 

ALT+Shift+DOWN ARROW Moves the pointer from the phonetic guides back to the parent string of characters. 

ALT+Shift+F10 Display the menu or message for a smart tag. If more than one smart tag is present, switch to the next

smart tag and display its menu or message. 

ALT Shift LEFT ARROW Ungroups rows or columns in Microsoft Excel. 

ALT+Shift+LEFT ARROW Ungroups grouped items in a PivotTable field. 

ALT+Shift+RIGHT ARROW Groups rows or columns. 

ALT+Shift+RIGHT ARROW Groups the selected items in a PivotTable field. 

ALT+Shift+TAB Switch to the previous program. 

ALT+Shift+UP ARROW In Japanese text for which you've displayed phonetic guides, moves the pointer into the phonetic

guides. 

ALT+SPACEBAR Display the Control menu for the Excel window. 

ALT+T Apply or remove the top border. 

ALT+TAB Switch to the next program. 

ALT+U Apply or remove the upward diagonal border. 

ALT+UP ARROW Display previous Help topics in the Assistant list 

ALT UP ARROW Closes the AutoFilter list for the current column in Microsoft Excel. 

ALT+V If cells in multiple columns are selected, apply or remove the vertical divider. 

ALT+X Pressed immediately after typing the hexadecimal code for a unicode character, converts the numbers

to the character. 

Arrow keys Move between options in an open drop-down list, or between options in a group of options. 

Arrow keys Move around the page when zoomed in. 

Arrow keys Move one cell up, down, left, or right. 

Arrow keys Move one character up, down, left, or right in Microsoft Excel. 

BACKSPACE In the Formula Bar, delete one character to the left. 

BACKSPACE Edit the active cell and then clear it, or delete the preceding character in the active cell as you edit cell

contents. 

CTRL Switches between command mode and dictation mode. 

CTRL+' (apostrophe) Copies a formula from the cell above the active cell into the cell or the Formula Bar. 

CTRL+/ Select the array (array: Used to build single formulas that produce multiple results or that operate on a

group of arguments that are arranged in rows and columns. An array range shares a common formula;

an array constant is a group of constants used as an argument.) containing the active cell. 

CTRL ; (semicolon) Enter the date in Microsoft Excel. 

CTRL+[ (opening bracket) Select all cells directly referenced by formulas in the selection. 

CTRL+\ In a selected row, select the cells that don't match the value in the active cell. 

CTRL+] (closing bracket) Select cells that contain formulas that directly reference the active cell. 
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CTRL+` (single left quotation mark) Alternate between displaying cell values and displaying formulas. 

CTRL 0 (zero) Hide the selected columns in Microsoft Excel. 

CTRL+0 (zero) Hides the selected columns. 

CTRL+1 Display the Format Cells dialog box. 

CTRL+5 Apply or remove strikethrough. 

CTRL+6 Alternate between hiding objects, displaying objects, and displaying placeholders for objects. 

CTRL+7 Show or hide the Standard toolbar. 

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hide the selected rows. 

CTRL+9 Hides the selected rows. 

CTRL+A Select the entire Help topic 

CTRL+A Select the entire worksheet. 

CTRL+A When the insertion point is to the right of a function name in a formula, display the Function Arguments

dialog box. 

CTRL+ALT+F9 Calculate all worksheets in all open workbooks, regardless of whether they have changed since the

last calculation. 

CTRL ALT LEFT ARROW Switch to the next nonadjacent selection to the left in Microsoft Excel. 

CTRL+ALT+RIGHT ARROW In nonadjacent selections, switch to the next selection to the right. 

CTRL+ALT+Shift+F9 Rechecks dependent formulas and then calculates all cells in all open workbooks, including cells not

marked as needing to be calculated. 

CTRL+arrow key Move to the edge of the current data region (data region: A range of cells that contains data and that is

bounded by empty cells or worksheet borders.). 

CTRL+B Apply or remove bold formatting. 

CTRL+BACKSPACE Scroll to display the active cell. 

CTRL+C Copy the selected items to the Clipboard 

CTRL+C Copy the selected cells. 

CTRL+C, immediately followed by

another CTRL+C

Display the Microsoft Office Clipboard (multiple copy and paste). 

CTRL+D Fill down. 

CTRL DELETE Delete text to the end of the line in Microsoft Excel. 

CTRL+DOWN ARROW Display the full set of commands on the task pane menu 

CTRL+DOWN ARROW Display the full set of commands on a menu. 

CTRL+DOWN ARROW or CTRL+RIGHT

ARROW

Move to the last page when zoomed out. 

CTRL+END Move to the last cell on the worksheet, in the bottom-most used row of the rightmost used column. 

CTRL+ENTER Fill the selected cell range with the current entry. 

CTRL+ESC Display the Windows Start menu. 

CTRL F10 Maximize or restore the selected workbook window in Microsoft Excel. 

CTRL+F3 Define a name. 

CTRL+F5 Restore the window size of the selected workbook window. 

CTRL+F6 When more than one workbook window is open, switch to the next workbook window. 

CTRL+F7 When a workbook window is not maximized, perform the Move command (on the Control menu for the

workbook window). Use the arrow keys to move the window, and when finished press ESC. 

CTRL+F8 When a workbook window is not maximized, perform the Size command (on the Control menu for the

workbook window). Use the arrow keys to resize the window, and when finished press ESC. 

CTRL+F9 Minimize a workbook window to an icon. 

CTRL HOME Move to the beginning of the worksheet in Microsoft Excel. 

CTRL+HOME or CTRL+END Move to the top or bottom of the selected gallery list 

CTRL+HYPHEN Delete the selected cells. 

CTRL+I Apply or remove italic formatting. 
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CTRL+K Insert a hyperlink (hyperlink: Colored and underlined text or a graphic that you click to go to a file, a

location in a file, an HTML page on the World Wide Web, or an HTML page on an intranet. Hyperlinks

can also go to newsgroups and to Gopher, Telnet, and FTP sites.). 

CTRL+LEFT ARROW Move one word to the left. 

CTRL+LEFT Shift Switches to left-to-right paragraph direction (the text must contain only neutral characters). 

CTRL P Print the current Help topic in Microsoft Excel 

CTRL+P or CTRL+Shift+F12 Display the Print dialog box. 

CTRL+PAGE DOWN Move to the next sheet in the workbook. 

CTRL+PAGE DOWN Start a new, blank record. 

CTRL+PAGE DOWN Selects a chart sheet: selects the next sheet in the workbook, until the chart sheet you want is

selected. 

CTRL+PAGE UP Move to the previous sheet in the workbook. 

CTRL PAGE UP Move to the first record in Microsoft Excel. 

CTRL+PAGE UP Selects a chart sheet: selects the previous sheet in the workbook, until the chart sheet you want is

selected. 

CTRL+PERIOD Move clockwise to the next corner of the selected range. 

CTRL+R Fill to the right. 

CTRL+RIGHT ARROW Move one word to the right. 

CTRL+RIGHT Shift Switches to right-to-left paragraph direction (the text must contain only neutral characters (neutral

characters: Characters that do not have strong right-to-left or left-to-right language attributes.

Numerals are an example of neutral characters.)). 

CTRL+Shift+! Apply the Number format with two decimal places, thousands separator, and minus sign (-) for

negative values. 

CTRL+Shift+ (quotation mark) Copy the value from the cell above the active cell into the cell or the Formula Bar. 

CTRL Shift #Apply the Date format with the day, month, and year in Microsoft Excel. 

CTRL+Shift+$ Apply the Currency format with two decimal places (negative numbers in parentheses). 

CTRL+Shift+% Apply the Percentage format with no decimal places. 

CTRL+Shift+& Apply the outline border to the selected cells. 

CTRL+Shift+( (opening parenthesis) Unhide any hidden rows within the selection. 

CTRL+Shift+( (opening parenthesis) Unhides any hidden rows within the selection. 

CTRL+Shift+) (closing parenthesis) Unhide any hidden columns within the selection. 

CTRL+Shift+) (closing parenthesis) Unhides any hidden columns within the selection. 

CTRL+Shift+* (asterisk) Select the current region around the active cell (the data area enclosed by blank rows and blank

columns). In a PivotTable report, select the entire PivotTable report. 

CTRL+Shift+* (asterisk) Selects an entire PivotTable report. 

CTRL Shift : (colon) Enter the time in Microsoft Excel 

CTRL+Shift+@ Apply the Time format with the hour and minute, and AM or PM. 

CTRL+Shift+^ Apply the Exponential number format with two decimal places. 

CTRL+Shift+_ Remove the outline border from the selected cells. 

CTRL+Shift+{ (opening brace) Select all cells directly or indirectly referenced by formulas in the selection. 

CTRL+Shift+| In a selected column, select the cells that don't match the value in the active cell. 

CTRL+Shift+} (closing brace) Select cells that contain formulas that directly or indirectly reference the active cell. 

CTRL Shift ~ Apply the General number format in Microsoft Excel. 

CTRL+Shift+A When the insertion point is to the right of a function name in a formula, insert the argument names and

parentheses. 

CTRL+Shift+arrow key Extend the selection to the last nonblank cell in the same column or row as the active cell. 

CTRL+Shift+B Opens the Address Book. 

CTRL+Shift+END Extend the selection to the last used cell on the worksheet (lower-right corner). 

CTRL+Shift+ENTER Enter a formula as an array formula (array formula: A formula that performs multiple calculations on

one or more sets of values, and then returns either a single result or multiple results. Array formulas

are enclosed between braces { }, and are entered by pressing CTRL+SHFT+ENTER.). 
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CTRL+Shift+F3 Create names (name: A word or string of characters that represents a cell, range of cells, formula, or

constant value. Use easy to understand names, such as Products to refer to hard to understand

ranges, such as Sales!C20:C30.) from row and column labels. 

CTRL+Shift+F6 Switch to the previous workbook window. 

CTRL Shift G Creates a message flag in Microsoft Excel. 

CTRL+Shift+HOME Extend the selection to the beginning of the worksheet. 

CTRL+Shift+LEFT ARROW Select or unselect one word to the left. 

CTRL+Shift+O (the letter O) Select all cells that contain comments. 

CTRL Shift PLUS SIGN Insert blank cells in Microsoft Excel. 

CTRL+Shift+RIGHT ARROW Select or unselect one word to the right. 

CTRL+Shift+SPACEBAR With an object selected, select all objects on a sheet. 

CTRL+Shift+TAB or CTRL+PAGE UP Switch to the previous tab in a dialog box. 

CTRL+Shift+Z When the AutoCorrect Smart Tags is displayed, undo or redo the last automatic correction. 

CTRL SPACEBAR Select the entire column in Microsoft Excel. 

CTRL+TAB In Help, switch to the next tab 

CTRL+TAB When a menu or toolbar (toolbar: A bar with buttons and options that you use to carry out commands.

To display a toolbar, use the Customize dialog box (point to Toolbars on the View menu and click

Customize). To see more buttons, click Toolbar Options at the end of the toolbar.) is active, move to a

task pane. (You may need to press CTRL+TAB more than once.) 

CTRL+TAB or CTRL+PAGE DOWN Switch to the next tab in a dialog box. 

CTRL+TAB or CTRL+Shift+TAB When a toolbar is selected, select the next or previous toolbar. 

CTRL+U Apply or remove underlining. 

CTRL+UP ARROW or CTRL+LEFT

ARROW

Move to the first page when zoomed out. 

CTRL+V Paste copied cells. 

CTRL+W or CTRL+F4 Close the selected workbook window. 

CTRL+X Cut the selected cells. 

CTRL Z Undo the last action in Microsoft Excel. 

CTRL+Z Undo the last action. 

DELETE Delete the character to the right of the insertion point, or delete the selection. 

DELETE Clear the contents of the selected cells. 

DOWN ARROW In Help, select the next book or Help topic 

DOWN ARROW Select the next item in a smart tag menu. 

DOWN ARROW Move to the same field in the next record. 

DOWN ARROW Selects the next item in the AutoFilter list. 

DOWN ARROW Selects the next item in the list in Microsoft Excel. 

DOWN ARROW Select the previous group of elements in a chart. 

DOWN ARROW or UP ARROW Move among choices in a selected submenu; move among certain options in a group of options 

DOWN ARROW or UP ARROW When a menu or submenu is open, select the next or previous command. 

END Move to the end of the entry. 

END Move to the cell in the lower-right corner of the window. 

END Selects the last item in the AutoFilter list. 

END Selects the last visible item in the list. 

END key Turn End mode on or off in Microsoft Excel. 

END+arrow key Move by one block of data within a row or column. 

END+ENTER Move to the rightmost nonblank cell in the current row. This key sequence does not work if you have

turned on transition navigation keys (Tools menu, Options command, Transition tab). 

END+HOME Move to the last cell on the worksheet, in the bottom-most used row of the rightmost used column. 

END+Shift+arrow key Extend the selection to the last nonblank cell in the same column or row as the active cell. 

END+Shift+ENTER Extend the selection to the last cell in the current row. This key sequence does not work if you have
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turned on transition navigation keys (Tools menu, Options command, Transition tab). 

END+Shift+HOME Extend the selection to the last used cell on the worksheet (lower-right corner). 

ENTER In the Help windows, perform the action for the selected Show All, Hide All, hidden text, or hyperlink 

ENTER In Help, open a selected book or Help topic in Microsoft Excel 

ENTER Perform the action for the selected Show All, Hide All, hidden text, or hyperlink 

ENTER Perform the action for the selected item in a smart tag menu. 

ENTER Open the selected menu, or perform the action for the selected button or command. 

ENTER Perform the action for the default command button in the dialog box (the button with the bold outline,

often the OK button). 

ENTER Move from top to bottom within the selected range in Microsoft Excel. 

ENTER Complete a cell entry and select the cell below. 

ENTER Complete a cell entry from the cell or Formula Bar. 

ENTER Complete a cell entry and select the next cell below. 

ENTER Move to the first field in the next record. 

ENTER Filters the list based on the item selected from the AutoFilter list. 

ENTER Closes the list and displays the selected items. 

ENTER (in a cell with a hyperlink) Activate a hyperlink in Microsoft Excel. 

ESC Close an Assistant message or a tip 

ESC Close the smart tag menu or message. 

ESC Close an open menu. When a submenu is open, close only the submenu. 

ESC Cancel the command and close the dialog box. 

ESC Cancel a cell entry. 

ESC Cancel an entry in the cell or Formula Bar. 

ESC Cancel a cell entry in Microsoft Excel 

ESC Stops reading when text is being read aloud. 

F1 Display the Assistant balloon (if the Assistant is turned off, F1 opens the Help window) 

F1 Display the Help window if the Assistant is turned off (if the Assistant is turned on, F1 displays the

Assistant balloon). 

F10 or ALT Select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of

menus. A menu bar can be the built-in menu bar or a custom menu bar.), or close an open menu and

submenu at the same time. 

F11 or ALT+F1 Creates a chart of the data in the current range. 

F2 Move the insertion point into the Formula Bar when editing in a cell is turned off. 

F2 Edit the active cell and position the insertion point at the end of the cell contents. 

F3 Paste a defined name (name: A word or string of characters that represents a cell, range of cells,

formula, or constant value. Use easy to understand names, such as Products to refer to hard to

understand ranges, such as Sales!C20:C30.) into a formula. 

F4 or ALT+I Open the Look in list 

F4 or CTRL Y Repeat the last action in Microsoft Excel. 

F5 Refresh the file list 

F5 Display the Go To dialog box. 

F6 In the Help windows, switch between the Help topic and the Contents, Answer Wizard, Index pane

(pane: A portion of the document window bounded by and separated from other portions by vertical or

horizontal bars. ) 

F6 Switch to the next pane in a worksheet that has been split (Window menu, Split command). 

F6 Move to a task pane (task pane: A window within an Office application that provides commonly used

commands. Its location and small size allow you to use these commands while still working on your

files.) from another pane in the program window. (You may need to press F6 more than once.) 

F6 Switch to the next pane in a worksheet that has been split (Window menu, Split command). 

F7 Display the Spelling dialog box in Microsoft Excel. 

F8 Turn extend mode on or off. In extend mode, EXT appears in the status line, and the arrow keys
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extend the selection. 

First letter of an option in a drop-down

list

Open the list if it is closed and move to that option in the list. 

HOME Move to the beginning of the entry. 

HOME Move to the beginning of the row. 

HOME Move to the cell in the upper-left corner of the window. 

HOME Move to the beginning of the line. 

HOME Selects the first item (All) in the AutoFilter list. 

HOME Selects the first visible item in the list. 

HOME or END Go to the beginning or end of a Help topic in Microsoft Excel 

HOME or END Select the first or last command on the menu or submenu. 

HOME or END Move to the beginning or end of a field. 

HOME or END When a menu or submenu is visible, select the first or last command on the menu or submenu 

LEFT ARROW For an item that has lower-level items displayed, hides the lower-level items. 

LEFT ARROW Selects the previous element within a group. 

LEFT ARROW or RIGHT ARROW Select the menu to the left or right. When a submenu is open, switch between the main menu and the

submenu. 

LEFT ARROW or RIGHT ARROW Move one character to the left or right. 

LEFT ARROW or RIGHT ARROW Scroll one column left or right in Microsoft Excel. 

LEFT ARROW or RIGHT ARROW Move one character left or right within a field. 

LEFT ARROW or RIGHT ARROW With two or more columns of field buttons, selects the button to the left or right. 

NUM LOCK, ALT+numeric pad numbers Enter a unicode character. 

PAGE DOWN Move down one screen. 

PAGE DOWN Move to the same field 10 records forward. 

PAGE UP Move up one screen. 

PAGE UP Move to the same field 10 records back. 

PAGE UP or PAGE DOWN Scroll toward the beginning or end of a Help topic in large increments 

PAGE UP or PAGE DOWN Scroll up or down in the selected gallery list 

PAGE UP or PAGE DOWN Move by one page when zoomed out. 

PRTSCR Copy a picture of the screen to the Clipboard. 

RIGHT ARROW For an item that has lower-level items available, displays the lower-level items. 

RIGHT ARROW Selects the next element within a group in Microsoft Excel. 

SCROLL LOCK Turn SCROLL LOCK on or off. 

SCROLL LOCK+Shift+END Extend the selection to the cell in the lower-right corner of the window. 

SCROLL LOCK+Shift+HOME Extend the selection to the cell in the upper-left corner of the window. 

Shift+arrow key Extend the selection by one cell. 

Shift+BACKSPACE With multiple cells selected, select only the active cell. 

Shift+CTRL+PAGE DOWN Select the current and next sheet. To cancel selection of multiple sheets, press CTRL+PAGE DOWN

or, to select a different sheet, press CTRL+PAGE UP. 

Shift+CTRL+PAGE UP Select the current and previous sheet. 

Shift+END Select from the insertion point to the end of the entry. 

Shift END Extend selection to the end of a field in Microsoft Excel. 

Shift+ENTER Move from bottom to top within the selected range. 

Shift+ENTER Complete a cell entry and select the previous cell above. 

Shift+ENTER Move to the first field in the previous record. 

Shift+F10 In Help, display a shortcut menu 

Shift+F10 Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a

particular item. To display a shortcut menu, right-click an item or press SHFT+F10.) 

Shift+F10 Open a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular

item. To display a shortcut menu, right-click an item or press SHFT+F10.); open a drop-down menu for
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the selected gallery item 

Shift+F10 Display the shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a

particular item. To display a shortcut menu, right-click an item or press SHFT+F10.) for the selected

item. 

Shift+F10 Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a

particular item. To display a shortcut menu, right-click an item or press SHFT+F10.) for a selected item

such as a folder or file 

Shift+F11 or ALT+Shift+F1 Insert a new worksheet. 

Shift F2 Edit a cell comment in Microsoft Excel. 

Shift+F3 In a formula, display the Insert Function dialog box. 

Shift+F4 Repeat the last Find action (same as Find Next). 

Shift+F5 Display the Find dialog box. 

Shift+F6 Switch to the previous pane in a worksheet that has been split. 

Shift+F6 Switch to the previous pane in a worksheet that has been split. 

Shift+F8 Add another range of cells to the selection; or use the arrow keys to move to the start of the range you

want to add, and then press F8 and the arrow keys to select the next range. 

Shift+F9 Calculate the active worksheet. 

Shift HOME Select from the insertion point to the beginning of the entry in Microsoft Excel. 

Shift+HOME Extend the selection to the beginning of the row. 

Shift+HOME Extend selection to the beginning of a field. 

Shift+LEFT ARROW Select or unselect one character to the left. 

Shift+LEFT ARROW Select the character to the left within a field. 

Shift+PAGE DOWN Extend the selection down one screen. 

Shift PAGE UP Extend the selection up one screen in Microsoft Excel. 

Shift+RIGHT ARROW Select or unselect one character to the right. 

Shift+RIGHT ARROW Select the character to the right within a field. 

Shift+SPACEBAR Select the entire row. 

Shift+TAB In the Help windows, select the previous hidden text or hyperlink, or the Browser View button at the top

of a Microsoft Office Web article. 

Shift+TAB Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office

Web article. 

Shift+TAB Move to the previous option or option group. 

Shift+TAB Move from right to left within the selected range. If cells in a single column are selected, move up. 

Shift TAB Complete a cell entry and select the previous cell to the left in Microsoft Excel. 

Shift+TAB When cell A1 is selected, moves to the Introduction box in the e-mail message header. In the message

header, moves to the Subject, Bcc (if displayed), Cc, To, and From (if displayed) boxes, then to the

address book for the Bcc, Cc, To, and From boxes, and then to cell A1. 

SPACEBAR Perform the action for the selected button, or select or clear the selected check box. 

SPACEBAR Checks, double-checks, or clears a check box in the list. Double-check selects both an item and all of

its llower-level items. 

SPACEBAR or ENTER Open the selected menu, or perform the action assigned to the selected button 

SPACEBAR, with the Help button

selected

Show the Assistant in a wizard or dialog box. To hide the Assistant, press SPACEBAR again. Note

that not all wizards or dialog boxes have Help provided by the Assistant. 

TAB Move to the Help button in a wizard 

TAB In the Help windows, select the next hidden text or hyperlink, or Show All or Hide All at the top of a

topic. 

TAB Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic. 

TAB Move to the next option or option group in Microsoft Excel. 

TAB Move between options or areas in the dialog box 

TAB Move between unlocked cells on a protected worksheet. 

TAB Move from left to right within the selected range. If cells in a single column are selected, move down. 
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TAB Complete a cell entry and select the next cell to the right. 

TAB Switches between the list, the OK button, and the Cancel button. 

TAB and Shift+TAB Move to each field in the record, then to each command button. 

TAB or Shift+TAB When a toolbar is selected, select the next or previous button or menu on the toolbar. 

TAB or Shift+TAB When a task pane is active, select the next or previous option in the task pane 

UP ARROW In Help, select the previous book or Help topic in Microsoft Excel 

UP ARROW Select the previous item in a smart tag menu. 

UP ARROW Move to the same field in the previous record. 

UP ARROW Selects the previous item in the AutoFilter list. 

UP ARROW Selects the previous item in the list. 

UP ARROW Selects the next group of elements in a chart in Microsoft Excel. 

UP ARROW or DOWN ARROW Scroll toward the beginning or end of a Help topic 

UP ARROW or DOWN ARROW Scroll one row up or down. 

UP ARROW or DOWN ARROW Selects the previous or next field button in the list on the right.  

Visit http://www.shortcutmania.com/ for more printable keyboard shortcuts


